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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Referto the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.
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Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

The ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 1/Os Analog/Digital PLUS Family PLCs
are Open Type Controllers. It is required that you install the ESP32
ETHERNET&WIFI&BLUETOOTH PLC 21 I/Os Analog/Digital PLUS PLC in a housing,
cabinet, or electric control room. Entry to the housing, cabinet, or electric control
room should be limited to authorized personnel. Failure to follow these installation
requirements could result in severe personal injury and/or property damage. Always
follow these requirements when installing ESP32 ETHERNET&WIFI&BLUETOOTH PLC
21 1/0s Analog/Digital PLUS family PLCs.

In case of installation or maintenance of the ESP32 ETHERNET&WIFI&BLUETOOTH PLC
21 1/0s Analog/Digital PLUS please follow the instructions marked in the Installation
and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

& Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le controleur.

Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.
Reportez-vous au Guide de l'utilisateur du controleur pour les considérations de
cablage.

Avant d'utiliser ce produit, il incombe a I'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 1/Os
Analog/Digital PLUS sont des contréleurs de type ouvert. Il est nécessaire d'installer
l'automate ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 1/Os Analog/Digital PLUS
dans un boitier, une armoire ou une salle de controle électrique. L'acces au boitier, a
I'armoire ou a la salle de commande électrique doit étre limité au personnel autorisé.
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Le non-respect de ces exigences d'installation peut entrainer des blessures graves
et/ou des dommages matériels importants. Respectez toujours ces exigences lors de
I'installation des automates de la famille ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21
I/Os Analog/Digital PLUS.

e En cas d'installation ou de maintenance du ESP32 ETHERNET&WIFI&BLUETOOTH PLC
21 1/0s Analog/Digital PLUS, veuillez suivre les instructions indiquées dans la section
Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmospheére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.

Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.
e Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
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equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.

Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: - Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification — Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’'S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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ETL Listing Mark-Direct Imprint information

RECOGNIZED
COMPONENT
o™ Conforms to UL Std. 61010-1
Conforms to UL Std. 61010-2-201
C us Certified to CSA Std. C22.2 No. 61010-1
LiSTED Certified to CSA Std. C22.2 No. 61010-2-201
Intertek
5016476
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INDUSTRIAL SHIELDS

1 General Description ESP32 ETHERNET&WIFI&BLUETOOTH
PLC 21 I/0s Analog/Digital PLUS product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and B the shield from above. It has 2 zones (A, B):

e The inputs in the zone B are named 10.X, being X any number suitable in the
Shield. Outputs are named as QO0.X.

N 7 v "
[ 1
&
= ‘
zz wow
538 z 2
O O Zz
<= N N
< N
' Purales yrsiss l‘ BZONE

{ . -m2i.,' AZONE
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1.2 Zone Distribution

Communication

)

Analog

Y

Digital

The distribution of the different

features that

provide the

Rev. 0: 05-02-2021

ESP32

ETHERNET&WIFI&BLUETOOTH PLC 21 1/0Os Analog/Digital PLUS 21 I/Os PLUS is

the following one:

Shield

B Zone

Analog Shield

13 Inputs

(13 Digital inputs,
6 of which can
work as Analog
Input)

8 Outputs

(8 Digital Outputs,
3 of which can
work as Analog
Output)

13
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1.3 A Zone Features

Shield

A Zone

Communication
Shield

(1x) Ethernet

(1x) WiFi

(1x) BLE

(1x) USB

(1x) 12C

(1x) RS-232

(1x) HALF/FULL Duplex RS-485
(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

1.4

L

Mechanical dimension

Rev. 0: 05-02-2021
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1.5 General Features

Rev. 0: 05-02-2021

CONECTABLE PLC ARDUINO 24Vcc ESP32
ETHERNET&WIFI&BLUETOOTH PLC 21 1/0S
ANALOG/DIGITAL PLUS

MODEL TYPE A+B Zone
Fuse protection (2.5A)
Input Voltage 12_t0?2:NdC Polarity protection
24 Vvd
Input rated voltage =C
Rated Power 30W
| max. 1.5A
Size 101x70.1x119.5
Clock Speed External: 240 MHz Internal: 8 MHz
External Flash AMB
Memory
SRAM 4 MB
EEPROM 2 MB

12C — Ethernet Port — WiFi — BLE — USB — RS485 —

Communications RS232 — SPI

Max232-Max485-W5500

Only meant for uploading or debugging, not

USB consideration! always connected as a serial in a project!

Cannot be working in a final
application

An/Dig Input 10Dbit
(0-10Vcce)

0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 VVdc

Digital Isolated Input
(24Vcce)

5 to 24Vdc
I min: 2to 12 mA
Galvanic Isolation
Rated Voltage: 24 VVdc

* Interrupt isolated
Input HS (24vce)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24Vdc

Analog Output 8bit
(0-10Vcce)

0 to 10Vac
I max: 20 mA
Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated
Output (24vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

Digital Isolated
Output Relay

220V Vdc
| max: 5A
Galvanic Isolation
Diode protected for Relay

15
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PWM lIsolated Output
8bit (24vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation

Diode Protected for Relay

Rated Voltage: 24Vdc

Expandability

I12C - 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal

(24vdc)

16
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2 Technical Specifications:

2.1  General Specifications:
Item ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 I/Os Analog/Digital PLUS
Power supply —_—
voltage DC power supply 12 to 24Vdc
Operating

voltage range DC power supply

11.4t025.4Vdc ===

Power

consumption DC power supply 30W max.
Power supply 2avde ===

External voltage

power supply Power supply 700Ma

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the
external AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 378g max.
2.2 Performance Specification:
Board ESP32 DevKit C (3,3V)

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar  to  the C.
http://arduino.cc/en/Tutorial/HomePage

Microcontroller ESP32
External Flash Memory 4MB
Program capacity (SRAM) 4MB

17
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PSRAM

2MB

Clock Speed

8MHz

2.3 Symbology

Table that includes all the symbology that is used in the serigraph of the ESP32
ETHERNET&WIFI&BLUETOOTH PLC 21 I/Os Analog/Digital PLUS PLC Arduino Ethernet 21

I/Os Analog/Digital PLUS:

Symbol Standard No. / Standard Symbol Meaning
Standard Title Reference No. /
Symbol Title
IEC 60417 / 5031 / Direct Indicates that the equipment is
] Graphical symbols Current suitable for direct current only;
I = for use on to identify relevant terminals
equipment
IEC 60417/ 5032 / Alternating | Indicates that the equipment is
Graphical symbols Current suitable for alternating current
for use on only; to identify relevant
N~ equipment terminals
IEC 60417 / 5130/ Pulse To identify the control by
Graphical symbols General which a pulse is started.
for use on
equipment
IEC 60417 / 5017 / Earth, To identify an earth (ground)
Graphical symbols Ground terminal in cases where
for use on neither the symbol 5018 nor
p— equipment 5019 is explicily required.
IEC 60417 / 5115/ Slgnal lamp To identify the switch by
Graphical symbols means of which the signal
for use on lamp(s) is (are) switched on or
equipment off.

Medical Devices CE Marking CE marking indicates that a
Directive product complies with
93/42/EEC applicable European Union
regulations
ISO 7000/ 0434B/ Indicates a potentially
Graphical symbols | Warning symbol hazardous situation which, if
for use on not avoided, could result in
equipment death or serious injury

18




Ref. 034001000200

Rev. 0: 05-02-2021

ISO 7000/ 5036 / Dangerous To indicate hazards arising
Graphical symbols Voltage from dangerous voltages

for use on

equipment

3 Precautions

Read this manual before attempting to use the ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21
I/Os Analog/Digital PLUS PLC Arduino Ethernet 21 1/Os Analog/Digital PLUS and follow its
descriptions for reference during operation.

3.1 ESP32 Board

This version of 10 1/Os Digital Module PLCs include ESP32 Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 I/Os Analog/Digital PLUS
according to the performance specifications described in this manual.

Before using ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 1I/Os Analog/Digital PLUS under
different conditions from what has been specified in this manual or integrating ESP32
ETHERNET&WIFI&BLUETOOTH PLC 21 I/Os Analog/Digital PLUS to nuclear control systems,
railroad systems, aviation systems, vehicles, combustion systems, medical equipment,
amusement machines, safety equipment and other systems, machines, and equipment that
may have a serious influence on lives and property if used improperly, consult your
INDUSTRIAL SHIELDS representative. Ensure that the rating and performance characteristics of
ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 I/Os Analog/Digital PLUS are sufficient for the
systems, machines, and equipment, and be sure to provide the systems, machines, and
equipment double safety mechanisms. This manual provides information for programming and
operating the ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 I/Os Analog/Digital PLUS.

4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically, it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up
automatically if using the boards.
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In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).

Steps:

1.

2.

Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings Networl:

Sketchbook: location:

C:\Users\Albert\Documents\Arduino Browse
Editor language: English (English) ~ | (requires restart of Arduino)

Editor font size 15

Interface scale: Automatic | 100 2 %  (requires restart of Arduing)

Show verbose output during:  [/] compilation upload
Compiler warnings: Nore

[(pisplay line numbers

[CJEnable Code Folding

Werify code after upload

[use external editor

Check for updates on startup

[ Update sketch files to new extension on save (,pde -> .ino)
Save when verifying or uploading

Additional Boards Manager URLs: )'mp://apps‘\ndusrrla\sh\elds‘cnm/ma\n/ardu\nnfhnar’ds/pac\'aqe_mdusma\sh\e\ds_\nde' ﬁ

More preferences can be edited directly in the file
Ci\Users\Albert\AppDatall_ocal\Arduino15\preferences, txt
(edit only when Arduino is not running)

Ok Cancel

In Additional Boards Manager URLs write the following:

Rev. 0: 05-02-2021

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3.

Press OK to save the changes.

20
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4. Tools -> Board: ... -> Boards Manager. Search for the industrialshields-esp32 board and
install the last version (it must be from the version 1.0.4 minimum):

@ Boards Manager

Type All ~ esp32|

industrialshields-esp32

version 1.0.4 INSTALLED

Boards included in this package:
WiFi/BT module, 10 10s PLC family.

Online Help
More Info

Select version Install Remave

Close

Following these steps, you will be able to see now the Industrial Shields Boards:

© sketch_febda | Arduino 1813 - o X
File Edit Sketch Tools Help

Auto Format QT

Archive Sketch

Fix Encoding & Reload
Manage Libraries
Serial Monitor

pui  Seral Plotter

ol

rur
WIFi101 / WIFININA Firmware Updater

} Board: "ESP32 PLC Family”™ 3 Boards Manager
Model: "ESP32 PLC 2110+ Arduino AVR Boards
Industrial Shields boards
Industrial Shieids ESP32 mog ] 10 10S PLC Family
Industrial Shields megaAVR foards » 8 ESP32 PLC Family
Programmer 3
Intel Cunie (32-bit) Boards
Burm Bootioader

Get Board Info

WiFi module
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Once it is selected the ESP32 PLC Family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.

@ sketch_febBda | Arduino 1813 - o ®
File Edit Sketch Tools Help

Auta Format =T
Archive Sketch
. FixEncoding & Reload

Manage Libraries. CtrlShifte]
Serial Monitor Cri=Shift+M
// pui Serial Plotter culsshitsl  run once:

WIFi101 / WiFININA Firmware Updater

} Board: "ESP32 PLC Family” B
Model, ‘ESP32 PLC 2110+ 2@ EsPI2RC2110+
Get Board Info

Pragrammer yun repeatedly:
Bum Boatioader

Also, there are some examples of programming in File -> Examples -> ESP32 PLC Family

Furthermore, there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

5 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 I/Os Analog/Digital PLUS 21
I/Os PLUS uses USB-B cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> ESP32 PLC Family
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- Select the correct ESP32 PLC Board:

@ sketch_febBda | Arduino 1813 - o ®
File E

t Sketch Toals Help

Auto Format aneT
Archive Sketch
Fix Encoding & Reload

Manage Libraries Ctrteshiftel P
Serial Monitor Curl+Shift+M
// pui Serial Pletter csshiftsl  run o

WIFI101 / WiFININA Firmware Updater

} Board: "ESP32 PLC Family”

Maodel “ESP32 PLC 21 10+" 3@ ESP32PLC2110+

Get Board Info

Programmer
8urn Bootioader

- Select correct port for your board.

@ sketch mar16a | Arduino 130 - 8 x
File Eit Sketch Tools Help

Autn Format culeT
Auchive Sketch
shetch marls Fix Encading & Reload

Serial Monitor CufeShittah &
Senial Plotter Cul+ShiftsL

VAR 101 Finmware Updater

Boare: “Arebox lamily” >
Incustial Shields:“Arcbox Analog” >

Fort i senal por

Get Board Info COM13 (Aackino Leonard)
Programmer: “Arduino as 57" >

Bun Boodoader
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6 How to connect PLC to power supply

- ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 1/Os Analog/Digital PLUS PLC is 12-24Vdc
supplied. IMPORTANT: The polarity IS NOT REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

e (T 7T
o > | ND POWER SUPPLY
< | U] ) I
:30!
= 8 . GND |
S -

e | \\/LC | 24 Vcc J

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm
DIN Rail:

-12vdc / 24Vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent

IRBE I

protection. There is a LED inductor for power status,
the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.
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7 ESP32 ETHERNET&WIFI&BLUETOOTH PLC 211/0s
Analog/Digital PLUS 21 1/0s PLUS Pinout

7.1 A Zone connection

Base
(common unit)
A Zone
5
9 g
o 5
o
3.3vdc -
5Vvdc -
GND -
3.3vdc -
5vdc -
GND -
SCL 12C/SS
SDA 12C/SS
GND -
1033 -
TX RX1/SS
RX TX1/SS
GND -
GND -
VN -
VP -
B- RS485
A+ RS485
GND RS485
50 SO SPI
51 SI SPI
52 SCK SPI
NC -
5Vvdc 5V
GND Gnd
GND Gnd

Communication Pins

Configuration Switch* (see section 8 for
configuring the communications.
Enabling communications disables some
1/0s)

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any device.

Base
(common unit)

A Zone

PLC
Function

Vdc Power Supply
GND GND

M

30V

/N
ot

Slini2/28vde

ava
<
=
A

£ om

2
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Power LED

_

!
.l

Ethernet microUSB

\/

RESET button

microSD l

Boot switch
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7.2 B Zone (Analog Shield)

B Zone I
- f’f‘{}
nalog:
EIJ % 0 to ?Dv‘dc
Digital:
e LgL) 5@;0u 24Vdc
Di&?m
S to 24Vdc
10.12 Analog/ Digital In
10.11 Analog/ Digital In a —it
10.10 Analog/ Digital In .
10.9 Analog/ Digital In Analog/Digital Inputs
10.8 Analog/ Digital In
10.7 Analog/ Digital In
()10.6/INT1 GND 10.6 Ll
10.6/INT12 Interrupt 1 In 16/NT <] s s Interrupt Inputs (isolated)
(-)I0.5/INTO GND 10.5 ;a’:j"]s)ﬁ“:!:l
10.5/INTO! Interrupt O In R
()10.4 GND 10.4 i [
10.4 Digital Input e 103-—f 8
(-)I0.3 GND 10.3 03 <% S
10.3 Digital Input x| . .
(0.2 GND 0.2 & my Digital Inputs (isolated)
10.2 Digital Input E“: T
(-)10.1 GND 10.1 1 s
10.1 Digital Input
(-)10.0 GND 10.0 | I
10.0 Digital Input
Top Zone
Led indicator 1/Os state e ) . .
A7 007 Configuration Switch*
:ﬁﬁ ﬁgﬁ (see section 8 to select the correct
B Zone : configuration for outputs).
& c B
O o 2 o Digtal
i % 2 O avac
S =} - Digital/PWH:
< w e
GND GND GND
A0.7% 6 Analog Out
A0.6* 5 Analog Out Analog Outputs
A0.5! 4 Analog Out 1
Q/Vdc - External Isolated Out Vdc :3: Voltage Supply/Reference for
COM(-) - External Isolated Out GND v .. R
Q0.7 6 Digital/PWM Out Digital/PWM Outputs (isolated)
QO0.61 5 Digital/PWM Out
Q0.5 4 Digital/PWM Out Digi
Q0.4 40 Digital Out igital Outputs
Q0.3 39 Digital Out
Q0.2 38 Digital Out U
Q0.1 37 Digital Out T
Q0.0 36 Digital Out

1 See section 8 to select suitable switch configuration for enable these connections.

NOTE: The Digital/Analog 1/Os in this device are connected to the ESP32 through I12C. For more information see the
Section 10.
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7.1 Interrupt equivalence table

ZONE ANALOG/DIGITAL ESP32 PIN

A 0.5 GPIO 27

0.6 GPIO 26

8 Switch Configuration
8.1 A Zone: Communications
Switch
ON OFF
A ZONE

NC/NC NC NC

NC/NC NC NC

NC/NC NC NC
USB/RS232 RS232 USB

@ -

OFF ON
NC NC
NC NC
NC NC
USB RS232

Rev. 0: 05-02-2021

USB/RS232: Changing between USB / RS232. If this switch is ON, it enables RS232
communication and disables the Programming USB. If this switch is OFF, it disables R$232
communication and enables the Programming USB. (Programming USB must be activated to

upload programs to the PLC).
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8.2 B Zone Swithces

B ZONE
SWITCH ON | OFF

NC - -
Q0.7 Q0.7 | A0.7
Q0.6 Q0.6 | AO.6
Q0.5 Q0.5 | A0.5

g NC

ozl Qo

Ziz| QO0.5

00

Rev. 0: 05-02-2021

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF

it can only act as an Analog Output.

If it is desired to use a Digital Output, the pin must be set to ON and the pin that will provide

this digital output is represented with Q0.X.

If it is desired to use an Analog Output, the pin must be set to OFF and the pin that will provide

this analog output is represented with A0.X.
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9 A Zone Features: Communications & RTC & uSD

9.1 RS-232

For the RS-232 communication protocol there is a switch that affects it. See the Section 8 for
more information.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

9.2 RS-485

The RS-485 protocol will be always enabled.

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

9.3 I2C

I2C communication DOES NOT REQUIRE a pull-up resistor for the ESP32
ETHERNET&WIFI&BLUETOOTH PLC 21 1/Os Analog/Digital PLUS 21 1/Os PLUS. The pull-up
resistor is already implemented in the PCB.

9.4 SPI

The ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 1/Os Analog/Digital PLUS pins used for the
SPI bus are summarized in the table below. For SPI bus MISO, MOSI and CLOCK pins are
common to all the connected devices to the ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 1/Os
Analog/Digital PLUS, conversely, each of the connected devices will have a single and
dedicated SS pin.

Function PLC connection
MISO SO
MOSI SI
CLOCK SCK

9.5 Ethernet

ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 I/Os Analog/Digital PLUS Ethernet port controller
is based on w5500 IC, which is the compatible IC compatible with Arduino Ethernet2 Shield
libraries. All Ethernet shield Arduino libraries are compatible with the ESP32
ETHERNET&WIFI&BLUETOOTH PLC 21 1/Os Analog/Digital PLUS. In the ESP32
ETHERNET&WIFI&BLUETOOTH PLC 21 1I/Os Analog/Digital PLUS, W5500 IC communicates to
the Mega board via SPI bus (SS Arduino Mega pin 10).
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9.1 WiFi5G

This device has got 5G Wi-Fi based on the chip ISM43340.
9.1 BLE

This device has got Bluetooth Low Energy provided by the ESP32.

9.2 RTC

ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 1/Os Analog/Digital PLUS RTC Module is based on
the DS1307 Chip. This chip works with the 12C protocol communication, so it is required to
have enabled the 12C protocol.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

9.1  I2C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case
it reads 5V when nothing is connected. The pull-up configuration is stablished by default in
these pins.

If it is meant to work them as a GPIO at 5V, it has to be considered that they are pull-up
inputs.

9.2 SPI- MISO/MOSI/SCK

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.3 uSD

The microSD uses the SPI communication to interact with the ESP32. The SPI protocol is always
enabled, as there are no switches that configure it.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD.
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y:
/& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

& Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est
hors ligne et en sécurité.
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10 Equivalence Table

The Digital/Analog I/Os of this device are connected to the ESP32 through 12C, using specific

Rev. 0: 05-02-2021

chips (see the Section 11). Here we have the equivalence tables (using Industrial Shields

libraries, we do not have to consider these equivalences):

10.1 AnaloglI/Os

Analog Inputs Analog Outputs
PLC Pinout | Chip ADDR Chip INDEX PLC Pinout Chip ADDR Chip INDEX
Zone A Zone A
0.7 0x49 2 AQ0.5 0x40 13
10.8 0x49 1 A0.6 0x40 6
10.9 0x48 3 AQ.7 0x40 7
10.10 0x48 2
10.11 0x48 1
10.12 0x48 0
10.1 Digital I/0s
Digital Inputs Digital Outputs
PLC Pinout | Chip ADDR | Chip INDEX GPIO PLC Pinout | Chip ADDR | Chip INDEX
Zone A Zone A
10.0 ADDR = 0x21 6 - 0.0 00 »
10.1 ADDR = 0x21 4 -
10.2 ADDR = 0x21 5 Q0.1 0x40 10
10.3 ADDR = 0x21 3 Q0.2 0x40 o
10.4 ADDR = 0x21 2 - Q0.3 0x40 8
10.5 GPIO = 27 Q0.4 0x40 12
10.6 GPIO = 26 Q0.5 0x40 13
Q0.6 0x40 6
Q0.7 0x40 7
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11 Internal I12C and SPI Connections

—_—

microSD

12C
PCA9685A
0x40
W5500 PCA9685A
. 0x41

KIX

S
ISM43340 RTC
DS3231 ~—m—m—— ————
R
MCP23008
0x20
I I I I ‘
N MCP23008
ADS101S ADS101S ‘ADS101S ADS101S a2l J
0x48 0x49 0Oxda y Oxdb

12 Instructions: How to upload a program
With these family devices, we must follow a certain protocol to successfully upload a program:

e Connect the microUSB cable to the microUSB port:

Power LED

!

-@ o -\Fl$

microSD

Ethernet microUss RESET button Boot switch

e Configure this switch (BOOT) in ON position:

Power LED

P _
B @ —@
| L

Ethernet microUSB RESET button

Boot switch
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e Upload the code.
e Once the code is uploaded, turn OFF the previous switch.

Power LED

_ @—@
LA

Ethernet microUSB RESET button

Boot switch

e Pulse the RESET button:

Power LED

B -8
] \

microSD

Ethernet microUSB RESET button Boot switch

Rev. 0: 05-02-2021
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13 Instructions for interconnection between Industrial Shields
controllers

13.1 RS-232 Communication:

-

~ M-Duino 21 /0s “_Another Industrial \'

PLUS ' | Shields PLC |

KRFC-6 Ferrite (4 Loops]
Tx (j‘n T Tx

SHIELDED CABLE

Ferrite KITA Ferrite KITA
GND Ny

XX | by
12124V ‘ @OOO( 12124V
/ ! / '

- \ > & I 1 >

13.2 RS-485 Communication:

13.2.1.1 Half Duplex

. M-Duino 211/0s *_ Another Industrial
' PLUS ' Shields PLC |

KRFC-6 Ferrite (4 Loops)

s [0 I
RS-485 B -.B RS-485
SHIELDED CABLE

Ferrite KITA Ferrite KITA

GND . ' L GND
)I k \
. T C [ ]
13.2.2 Full Duplex
“._ M-Duino 21 1/0s ~ " Another Industrial
PLUS | Shields PLC
A i
RS-485 3 RS-485
z
Ferrite KITA g| ) CAB| E Ferrite KITA
GND . SHIELDED CABLES | [ GND
12124\ )OOC)@ - @OO(X 12124y
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13.3 Ethernet

GND
12124V

KRFC-6 Ferrite

Rev. 0: 05-02-2021

I l

M-Duino 21 I/Os

Ferrite K

PLUS

Ethernet

: Another Industrial '

Shields PLC

Ferrite KITA

GND
P OO Gy

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.
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14 1/0 technical details:

Digital Output Waveform:

[l o e——
y

DIGITALOUT

DIGITAL OUT

PWM OUTPOUT

leE

4

Pomem—ny

ARDUIND PAWM OUT

CHi= S.@al| |5 5,660 M 1.88ms | CHI % 268GEm.)
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Analog Out Turn On:

]

ANALOGOUT

ANALDG OUT

ARDLINO OUT
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15 Typical Connections

(’fWTﬂL ISOLATED INPUT

GND 3\
@sﬂm o j]

SHIELDED CABLE
Ferrite KITA

j: Y
ik B oemaw
SHIELDED CABLE / Dountoad o MDUNO LAYOUT:
< I 1 S

Ferrite KIT
= -
2/24V

A

SHIELDED CABLE .|| Duunlont 20 MOURO LAYOUT:

¢)10.0
0.0

Rev. 0: 05-02-2021
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SHIELDED CABLE
2124V o o 0.7
GND

Ferrite KITA
=

Lo g ) e

SHIELDED CABLE =~/  Fremwemimshsssteson \
< et U

010V

— T2, Lo

Ferrite KITA

GND

- POWER
2224V B oemauasaocew

SHIELDED CABLE L:":‘:’W \
o—
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SHIELDED CABLE %%
51224V S,
GND
Ferrite KITA
GND
ol

12/24V

Ferrite KITA

o

Y

B owemuour

10.7

(3
SHIELDED CABLE J Downioed Sre MOUINO LAYOUT:
From: www industrisishiwids. com \

Rev. 0: 05-02-2021

SHIELDED CABLE

) "‘i‘”j@a

L

ALWAYS
CONNECTED

SHIELDED CABLEf Pty drussentt felipocd \_

&

VOUT = @/ Vde

42



Ref. 034001000200

SHIELDED CABLE

Ferrite KIT/

GNI}_'G

2124V

Rev. 0: 05-02-2021

VOUT = O/ Ve

SHIELDED CABLE

DIGITAL / PWM ISOLATED
OUTPUT

Ferrite KIT,

A

A \
E
v [

DIGITALFWAS OUT

SHIELDED CAEL? sty s ey il E

* See the switch
configutarion (ON)
I 512724V
{ =5 A
J ALWAYS
JU1 CONNECTED
® SHIELDED CABLE
VOUT = Q/ Vide
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" Soe the switch
configutarion (0N

Q/vde

COM (=) .&

ALWAYS
Jun CONNECTED
Ferrite KITA Q05 @
oo Lo VOUT = 0/ Vide
1224V DHETALPWA OUT
SHIELDED AaL%
\Wi »

SHIELDED CABLE

&
[®)
3

SHIELDED CABLE

Ferrite KITA —
(= 9) |} power

SHIELDED CABLE | Cowiead e soumouavour:
< I __ >

E
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16 Connector details:

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MC0,5/10-G-2,5THT

For 1/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference | MC 0,5/10-G-2,5 THT

Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm

Pin dimensions 0,8x0,8mm

Pin spacing 2,50mm

Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?

Rigid conduit section max. 0,5 mm?

Flexible conduit section min. 0,14 mm?

Flexible conduit section max. 0,5 mm?

Conduit section AWG/kcmil min. | 26

Conduit section AWG/kcmil max. | 20
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17 Mechanical Characteristics

- Dimension ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 1/0s
Analog/Digital PLUS 21 I/Os PLUS:

10
|
=
<
- DIN Rail mounting
Profilato a cappello TH 35-7,5 Prafilato o coppello TH 35-15
Top hat rail TH 35-7,5 Top hot rail TH 35-15
15 5
758,
1=0.04
15°
. RO8
R12
—_—  3=03 k08
o~ L
=
+
5 ——-L 1004
v Sezione A / Section A k12
0.3 max -~ 2,2 min. finoa / To 2,5 max
S| et
+
B Sezione A/ Sedtion A
CARATTERISTICHE METODO  UNMA"  BLEND FEATURES TEST UNITS BLEND
DI MISURA_PC/ABS METHOD PU/ABS
Meccaniche  Resigreo o tzione ol srenvemento ISTHDB38  MPo 88 Mechanical test Resiionce i tensile sess of vield ASTD638 MR 68
Resighien a taziongo ot ISTHDE3 Mo 4% Tngloshength ASTHD63S MR 4
Alyngomento o rotn K068 % 5] Ul k ASTMD638 % 59
Modulo n fesione KSTHOTH  MPe 2694 Plering moduls ASTHDTH0 MR 2694
Frova |20d conintoglo 5018014 XUt 55 rod st oched 15016014 X' 55
Termiche Temp di nmmolimento Viot, mekdoB  ASTI DIS2S  °C 114 Thermal fest  Vicot sodbening tomperotwe method B ASTRDISES 114
Tomgerots Rt 181 WPy KT8 °C 9 Roheting tomporctue 181 WPy ASTMDB8  C 91
Fisiche Peso o KUADTS2  gfand V] Physical test  Spacic guvity ASTHDT92  gv/and 121
Ritie nello stompo KTADISS % 04008 Hould rinkage ASTMD9SS % 0406
Mk Flow Index 260°C - 98N SN g1l 1 el Fow Index 260°C - 98K ASTHDIZ8  o/10’ 1l
Comportamento Aukesinguerzs (i di peso) It} V-0(08) Flame test Seff etinguisher thidkness in mm) o4 - V-0(0.8)
alla fiomma _Fib Incordescen 32 mm @521 °C 9% Ingondescents thigod 32 mm 69521 9%0
Ialtronic si riserva il diritto di modificare il moteriole con cui realizzo i propei prodotti Ialtronic con operate ony change of the moteriols without being obliged to forewarn.

senzo obbligo di preawiso.

For optimal operation of the product, it must be located in an electrical cabinet with 1K08
mechanical protection. The minimum IP protection degree required is IP56.
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18 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 I/Os Analog/Digital PLUS 21 1/Os
PLUS from heat, high voltaje and eletrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 I/Os Analog/Digital PLUS 21 I/Os PLUS. When
configuring the layout of the ESP32 ETHERNET&WIFI&BLUETOOTH PLC 21 1/Os
Analog/Digital PLUS 21 1/Os PLUS inside your panel, consider the heat-generating devices
and locate the electronic-type devices in the cooler areas of your cabinet. Reducing the
exposure to a high-temperature environment will extend the operating life of any
electronic device. Consider also the routing of the wiring for the devices in the electric
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cabinet. Avoid placing low-voltage signal wires and communications cables in the same
tray with AC power wiring and highenergy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring ESP32 ETHERNET&WIFI&BLUETOOTH
PLC 21 1/Os Analog/Digital PLUS 21 1/Os PLUS. Is designed for natural convection cooling.
For proper cooling, you must provide a clearance of at least 25 cm above and below the
devices. Also, allow at least 25 cm of depth between the front of the modules and the
inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel
Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.
Do not disassemble or modify the modules. This could lead to breakdowns or

malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25¢cm away from the PLC in all

48



Ref. 034001000200 Rev. 0: 05-02-2021

directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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19 Revision Table

Revision Number Date Changes

0 05/02/2021 First implementation

About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruités de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com

50


mailto:industrialshields@industrialshields.com

